About the author

Daniel Paiz lives in Tuxtla Gutiérrez, Chiapas, Mexico. He graduated from the Gestalt School of Art and Design in Tuxtla. As a graphic designer with experience in multiple areas of design and print, he has worked for several advertising agencies in Mexico and the United States. In the past few years he has been working in the sports industry, designing logos and identities for soccer clubs. Currently, he works from his own online studio for several brands, creating graphic projects and demonstrating the power of CorelDRAW to create professional designs. Daniel has been using CorelDRAW as his principal design tool since 2000 and has shared his expertise as a Beta-tester of CorelDRAW Graphics Suite since version X4. Visit his Web site at www.danielpaiz.mx.
Design of a Soccer Club Logo

The logo of a professional soccer team must be related to the local social, cultural, and economic scene. The imagery must inspire pride in loyal followers and communicate the essence of the team’s vision and values to the general public. In this case, the Chiapas soccer club was looking for a new logo that could better convey the team’s spirit, identity, and values (Figure 1).

Before I start working on the concept of the new logo, I analyze the old logo in order to understand the reasons why it was not successful. I notice that there is no relationship between the imagery and the team’s history, identity, or environment. The image reflects the soccer club’s name, but the jaguar’s head is turned to the left, which can be interpreted to mean retreat or escape from rivals.

Figure 1: New logo (left) and old logo (right)
Establishing the client’s needs

Before I begin, I must establish the general requirements and goals of the project and formulate a strategy to achieve them.

1. The logo does not have a regional identity.
   - Solution: Highlight local features.
   - Result: Fans will support the team as an expression of their culture and identity.

2. The imagery does not have the right graphic style.
   - Solution: Improve the style of the vector trace. It needs to be clean, well-defined, and easy to recognize.
   - Result: Improving the trace will have a direct impact on the aesthetics of the design and will create more possibilities for production.

3. The current concept does not adequately convey the team’s spirit and values.
   - Solution: Create a well-defined concept that includes better management of graphic elements.
   - Result: The image will project the right message and will be easier to understand.

Having a sound concept and a solid technical implementation can prevent many problems, from lack of visual appeal to difficulties in production when using the logo across different media and applications (Figure 2).

The tools in CorelDRAW allow me to cover all of these areas by optimizing my files from the beginning.

Figure 2: Examples of different applications and printed media
Researching the logo elements

When you work for a soccer club, you meet people who have dedicated their lives to the success of the team. They share common values and work passionately towards a common goal — to ensure that the club runs smoothly and to promote the team to the highest level of professional soccer.

There are a few guidelines to keep in mind when you design a sports logo:

- **Talk to the players and the people in the club.** Listen to their suggestions and ideas, get to know their needs and expectations.

- **Get to know the competition.** Research of the logos of other national teams gave me a broader idea of the soccer market and the strategies that each team uses to strengthen its graphic message. Do not copy or use elements of other logos. In this business, people always keep an eye on the competition.

- **Do not design from memory.** For example, whenever you want to draw an animal, observe the real animal. In this case, visiting the zoo helped me study the jaguar to find the right angle for the animal in the logo. The soccer ball is another example. I used a real soccer ball as a reference. I tore apart a couple of soccer balls and studied the way the pieces were attached to each other.

First, I have to identify the right elements to include in the logo — elements that will resonate with the team and the fans — and then I must document every element that I am planning to use and the rationale behind it.

**Soccer** — The soccer ball, and more specifically the Telstar model that was used in Mexico in the 1970 World Cup, has become a world-wide symbol of soccer. I want to use a partial image of the soccer ball and integrate it into the jaguar head, so I make 3D renderings of the ball to find the right angle (Figure 3). Had I simply used a full soccer ball, I would have ended up with the single most common element across all soccer logos.

**Jaguar** — The image of the jaguar is deeply ingrained in local culture and tradition. The animal, revered for its power and courage, is considered one of the iconic animals in the Chiapas state. The jaguar is the basic element in the design, as its shape, color, and expression define the logo (Figure 4).

**Geometric shapes from Mayan architecture** — The Mayan culture is native to this region of the country and has a huge influence across the entire Chiapas state. The Mayans are recognized and admired for their architectural achievements (Figure 5). I decide to merge the geometric shapes used by our ancestors with the spots of the jaguar to represent both elements in an abstract manner. The beauty and color of the rainforests are also represented by the mystic green in the final logo.

**Coat of arms** — In our culture, soccer players are considered the new warriors and are a source of pride for the fans. Currently, eleven soccer teams in Mexico use a coat of arms in their logo. The coat of arms is a symbol of the commitment to protect the honor of and represent the Chiapas state, as well as an important symbol of soccer culture throughout the world (Figure 6).
Figure 4: Studying the shape, color, and expression of the jaguar (photo by Arturo Arias López)

Figure 5: Elements of Mayan architecture help ground the logo in the history of the region (photo by Arturo Arias López).

Figure 6: The coat of arms is an important part of soccer culture across the world.
**Time to design**

The first step is to create a sketch. In this case, I start with the jaguar. At this stage, it’s a good idea to use a blue pencil (Figure 7), so that when I have a well-defined image, I can use black ink to identify the master trace (Figure 8). As the design evolves, I make decisions on the fly with regards to the sketch.

My plan is to partially integrate the soccer ball into the head of the jaguar, so that the jaguar’s fur spots take the shape of the hexagons of the traditional soccer ball (Figure 9). The decision to replace the natural spots of the jaguar with the soccer ball may sound like a crazy idea, but after I found the right angle, it suited the composition perfectly. I also remove the whiskers because they make the head take up too much space. In this way, the logo becomes more compact.

*Figure 7: Sketching process to define the jaguar head*

*Figure 8: The complete sketch*

*Figure 9: The soccer ball is partially integrated into the jaguar head.*
Image digitalization

The first step of the design process is complete. It’s worth mentioning that at this stage there isn’t a single straight line in the image, which makes digitalization very challenging. Using geometric shapes, I can find the most perfect possible trace, which involves finding the center of each curve used in the sketch. This can take a while depending on the skill of the designer. I use two tools: the Ellipse tool and the Smart fill tool.

The Smart fill tool allows you to create objects from the intersection of two lines (Figure 10). It doesn’t matter how complex the lines are; this tool is very useful for creating shapes from the filled areas. As a visual guide, I can use different outline colors for each object that I am digitalizing, so that I have better control. I start by creating intersecting circles using the Ellipse tool. Whenever I have a fully defined segment, I fill it using the Smart fill tool, and then I combine all segments into a single curve object (Figure 11 and Figure 12). This process is not difficult but it requires some patience.

![Figure 10: The blue objects are created from the space between the intersecting lines.](image1)

![Figure 11: Geometric details from the digitalized sketch. The Ellipse tool is used to create intersecting circles, and the Smart fill tool is used to fill the overlapping areas and convert them to objects.](image2)

![Figure 12: The jaguar head is gradually defined.](image3)
The digitalized drawing has some minor differences from the hand-drawn sketch, but the traces look better defined — clearly outlined eyes, rounded ears, longer teeth and tongue, thicker outlines (Figure 13).

Using the jaguar’s natural spots as a guide, I identify a pattern with six sides, which can be naturally incorporated into the hexagons of the soccer ball (Figure 14). Using the Contour tool (Ctrl + F9), I add two inside contours to each hexagon. First, I create a one-step contour (cyan) and separate the objects of the contour group (Ctrl + K). Then, I select the cyan object and apply the second one-step contour (magenta). Next, I separate the objects of the second contour group. I delete the middle step by selecting the original hexagon and the cyan object and clicking the Back minus front button on the property bar. I remove the colors, and I have the final result.

When I start incorporating the hexagons into the head, I run into a problem: the hexagons overlap with the eyes and mouth of the jaguar (Figure 15). However, I don’t need to use all hexagons to achieve the soccer ball effect, because the 3D rendering produces a sphere effect on the jaguar’s head, suggestive of a soccer ball. I delete a couple of hexagons and I am left with the three main jaguar spots.

I erase some parts of the hexagon objects to give them a more authentic look, similar to the jaguar’s natural spots, as well as to achieve harmony with the other elements, such as the jaguar’s eyes and ears.

Another technique that can help with the visual recognition of the shapes is to increase the spacing between the hexagons. Other adjustments include rounding of all corners and traces.

The next step is adding the team name to the logo (Figure 16). Finally, I add color and some shadows to make the image look less flat (Figure 17).
Figure 14: Creating hexagons based on the jaguar spots

Figure 15: Modifying and positioning the hexagons

Figure 16: Adding the team name
Final steps

The final steps in the logo design process include creating color variations, producing grayscale and monochromatic versions of the artwork, establishing minimum and maximum reproduction size to avoid distortions, and defining the safe area around the logo that is necessary to keep the image apart from other elements in visual materials (Figure 18).

Topics for the logo style guide

The style guide is a document that defines the requirements of the logo usage, so that anyone can use the design and understand the basic principles of its reproduction. The guidelines ensure accurate and consistent representation of the logo and guarantee that the logo delivers a strong and positive message.
Even though the purpose of this document is to provide instructions to the people responsible for the reproduction and distribution of the logo, it’s important that anybody — even people without any background in design — can understand it. For this reason, clarity is essential.

Some basic topics that I cover in the guide include background and purpose, size and color chart, typography, and guidelines for the use of corporate identity. With this information, I can ensure that all logo reproductions communicate the values that the brand represents.

**Designing the style guide**

Grids and margins are important elements in document design. A grid is a non-printable guide that helps the designer lay out text and images by dividing the text into columns to make it easier to read.

Personally, I use CorelDRAW like a blank canvas; I don’t like to limit my workspace, so I typically disable the page border (click **Layout > Page setup**, and disable the **Show page border** check box). In this case, however, a page border gives me better control over the text columns.

A square page layout represents some extra challenges, as it is not a conventional format. I decide to divide the page into three sections to create a visually balanced and well-defined composition (Figure 19). The top, left, and right margins are 1 cm, and the bottom one is 1.618 cm. These proportions are also known as the “golden ratio.” Many artists use the golden ratio in their artwork to produce aesthetically pleasing compositions.

The three-column layout simply provides the basic design framework; it does not limit my ability to position objects as I like. A quick way to create columns with equal dimensions is to make a paragraph text frame (by dragging with the **Text** tool) and then divide it into columns of equal width. To calculate the dimensions of the text frame, I subtract the margins from the page size. With the current margins, for example, if the document is 25.4 x 25.4 cm, the text frame should be 23.4 x 22.7 cm, so I type these values in the **Object size** boxes on the property bar.

After I create the text frame, I open the **Layout** toolbar (**Window > Toolbars > Layout**) and click the **Columns** button. In the **Column settings** dialog box, I increase the number of columns to three, with a gutter of 0.5 cm. The spacing between the columns is adjusted automatically so that they are evenly spaced across the frame. Alternatively, you can calculate the width of each column yourself. CorelDRAW offers you the flexibility to accomplish the same task by using different features depending on your workflow.

Next, I press `Ctrl + K` (or click **Object > Break apart**) to split the columns and work with them independently while keeping the layout flexible. When I break the columns apart, they become three separate paragraph text objects, which are no longer connected. This is an easy way to get several paragraph frames that are evenly spaced on the page. Since the style guide will contain text in two different languages, I don’t want the columns to be linked.
When I design a multipage document containing text, I try to optimize my workflow. For example, creating text styles provides a quick way to ensure consistent formatting across multiple pages without imposing limits on the content or composition (Figure 20). A style can include more than one text property, such as color and font size. For example, if I want all titles to use a large font size, I don’t have to format them all one by one. Instead, I format one title, open the Object styles docker (Window ▸ Dockers ▸ Object styles or Ctrl + F5), and drag and drop the formatted title in the Style sets folder to automatically create a text style based on this formatting. After this, I can apply the style to any text by selecting the text and double-clicking the style set in the docker.

Placeholder text (right-click a blank column, and click Insert placeholder text) can help a lot with the design and layout of text and graphics. The traditional “Lorem ipsum” placeholder text has a structure that is similar not only to English writing, but to many other languages as well, so it can give me a good reference point for the visual flow of body text. It’s also very useful when a client must review only the graphics in a project. The placeholder text helps the client focus on the graphics, saving him the time and effort of providing unnecessary feedback on text that may still be work in progress.
Don’t be afraid of white space. The so-called negative space isn’t really so negative. It helps to create a balanced and harmonious composition (Figure 21). Remember the rule of thirds: 1/3 text, 1/3 image, 1/3 white space.

Use less content on each page for greater visual impact. This project is a bilingual style guide, so all information is repeated in two languages, but if I had used a single language, I could have easily kept the same layout, with only half the text per page. To compensate for the unequal column length, I use a slightly smaller font for one of the languages (Figure 22).

Keep in mind that the image on screen may look different when printed, and you can avoid unpleasant surprises by soft proofing (click the **Proof colors** button on the status bar). It’s important to turn on color proofing every now and then to see a preview of the printed document (Figure 23 and Figure 24). For more information, see “Soft proofing” on page 98.
When you are ready to send the project to the client or printer, I recommend publishing it as a PDF to prevent accidental changes to the content prior to printing. Generally speaking, the client is likely to request additional changes, so unless the client asks for it, you don’t need to submit the original .cdr file.

In conclusion, if you have an idea, no matter how complex, CorelDRAW provides the tools you need to make it happen, with the most professional results and high-quality imagery in both printed and digital media.